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IP Facts

Introduction

The Xilinx® LogiCORE™ IP Video Mixer core
provides a flexible video processing block for alpha
blending and compositing multiple video and/or
graphics layers. Support for up to eight layers, with
an optional logo layer, using a combination of video
inputs from either frame buffer or streaming video
cores (through AXI4-Stream interfaces) is provided.
The core is programmable through a comprehensive
register interface to control frame size, background
color, layer position, and the AXI4-Lite interface. A
comprehensive set of interrupt status bits is
provided for processor monitoring.

Features

» Supports (per pixel) alpha-blending of eight
video/graphics and logo layers

+ Optional logo (in block RAM (BRAM)) layer with
color transparency support

+ Layers can either be memory mapped AXI4
interface or AXI4-Stream

* Provides programmable background color

* Provides programmable layer position and size
» Provides scaling of layers by 1x, 2x, or 4x

« Optional built-in color space conversion

« Supports RGB, YUV 444, YUV 422, YUV 420

« Supports 8, 10, 12, and 16 bits per color
component input and output on stream
interface, 8-bit and 10-bit per color component
on memory interface

* Supports semi-planar memory formats next to
packed memory formats

« Supports spatial resolutions from 64 x 64 up to
4,096 x 2,160

« Supports 4K 60 fps in all supported device
families ()

1. Performance on low power devices might be lower.

Video Mixer v2.0
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LogiCORE™ IP Facts Table

Core Specifics

UltraScale+™ Families

Supported UltraScale™ Architecture

Device Family(}) Zynq®-7000 All Programmable SoC
7 Series

supported User AXI4-Master, AXI4-Lite, AXI4-Stream(®

Interfaces

Resources Performance and Resource Utilization web page

Provided with Core

Design Files Not Provided

Example Design Yes

Test Bench Not Provided

Constraints File Xilinx Design Constraints (XDC)

i,'lr:;;lt'on Encrypted RTL
Supported Standalone
S/W Driver® DRM/KMS

Tested Design Flows(4)

Design Entry Vivado® Design Suite

For supported simulators, see the

simulation Xilinx Design Tools: Release Notes Guide.

Synthesis Vivado Synthesis

Support

Provided by Xilinx at the Xilinx Support web page

www.Xilinx.com

Notes:

1. For a complete list of supported devices, see the Vivado IP
catalog.

2. Video protocol as defined in the “Video IP: AXI Feature
Adoption” section of Vivado Design Suite: AXI Reference
Guide (UG1037) [Ref 1].

3. Standalone driver details can be found in the software
development kit (SDK) directory (<install_directory>/SDK/
<release>/data/embeddedsw/doc/xilinx_drivers.htm). Linux
OS and driver support information is available from the
Xilinx Wiki page.

4. For the supported versions of the tools, see the
Xilinx Design Tools: Release Notes Guide.
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Chapter 1

Overview

The Xilinx® LogiCORE™ IP Video Mixer produces one single output video stream from
multiple external video and/or graphics sources. Sources can be dynamically positioned,
scaled, and combined using alpha-blending.

Feature Summary

The Video Mixer is a highly configurable IP core that supports blending of up to eight video
and/or graphics layers plus an additional logo layer into one single output video stream. All
layers except the master layer can either be a memory mapped AXI4 interface or
AXI4-Stream based. Alpha-blending (global or per pixel) and scaling is supported per layer.
Finally, built-in color space conversion between RGB and YUV 4:4:4 and chroma re-sampling
between YUV 4:4:4, YUV 4:2:2, and YUV 4:2:0 is optionally available.

The mixer provides an optional logo layer. It blends a logo that is stored in block RAM on
the top-most layer. A programmable color key can be used to make part of the logo
transparent. Also, alpha-blending (global or per pixel) can be used for logo transparency.

Alpha-blending is the convex combination of two image layers allowing for transparency.
Each layer in the mixer has a fixed Z-plane order; or conceptually, each layer resides closer
to the observer having a different depth. Thus, the image and the image directly "over" it
are blended. The order and amount of blending is programmable in real-time. This can
either be done through a global alpha, that is, every pixel uses the same alpha value, or
through a per pixel alpha value in case either the RGBA8, BGRAS8, or YUVA8 memory video
format is selected. Per pixel alpha also supports RGBA and YUVA444 streaming video
formats.

Scaling by means of pixel and line repeat is supported, and provides scaling of layers by 1x,
2x, or 4x. This feature might be used to save on memory bandwidth used by a layer, that is,
a memory layer can read in a 1,920 x 1,080 frame buffer while scaling it up on-the-fly to a
3,840 x 2,160 resolution.

The Video Mixer supports parallel processing of multiple pixels per clock cycle allowing
support for resolutions beyond 1080p60 with up to three color components, each of 8, 10,
12, or 16 bits.
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Applications

Applications range from broadcast and consumer, automotive, medical and industrial
imaging, and can include the following:

« Video surveillance
* Machine vision
« Video conferencing

« Set-top box displays

Licensing and Ordering Information

This Xilinx LogiCORE IP module is provided under the terms of the Xilinx Core License
Agreement. The module is shipped as part of the Vivado Design Suite. For full access to all
core functionalities in simulation and in hardware, you must purchase a license for the core.
Contact your local Xilinx sales representative for information on pricing and availability.

For more information, visit the Video Mixer product web page.

Information about other Xilinx LogiCORE IP modules is available at the Xilinx Intellectual
Property page. For information on pricing and availability of other Xilinx LogiCORE IP
modules and tools, contact your local Xilinx sales representative.
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Chapter 2

Product Specification

Standards

The Video Mixer is compliant with the AXI4-Stream Video Protocol, AXI4-Lite interconnect
and memory mapped AXI4 interface standards. For additional information, see the "Video
IP: AXI Feature Adoption” section of the Vivado Design Suite: AXI Reference Guide (UG1037)
[Ref 1].

Performance

The following sections detail the performance characteristics of the Video Mixer.

Maximum Frequencies
The following are typical clock frequencies for the target devices:

«  Virtex®-7 and Virtex UltraScale™ devices with -2 speed grade or higher: 300 MHz
«  Kintex®-7 and Kintex UltraScale™ devices with -2 speed grade or higher: 300 MHz
. Artix®-7 devices with -2 speed grade or higher: 150 MHz

The maximum achievable clock frequency can vary. The maximum achievable clock
frequency and all resource counts can be affected by other tool options, additional logic in
the device, using a different version of Xilinx® tools, and other factors.

Throughput

The Video Mixer supports bi-directional data throttling between its AXI4-Stream slave and
master interfaces. If the slave side data source is not providing valid data samples
(s_axis_video_tvalid is not asserted), the core cannot produce valid output samples
after its internal buffers are depleted. Similarly, if the master side interface is not ready to
accept valid data samples (m_axis_video_tready is not asserted) the core cannot
accept valid input samples after its buffers become full.
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If the master interface is able to provide valid samples (s_axis_video_tvalid is High)
and the slave interface is ready to accept valid samples (m_axis_video_tready is High),
typically the core can process and produce one, two, or four pixels specified by Samples
Per Clock in the Vivado Integrated Design Environment (IDE) per ap_c1k cycle.

However, at the end of each scan line and frame the core flushes internal pipelines for
several clock cycles, during which the s_axis_video_tready is deasserted signaling that
the core is not ready to process samples.

When the Video Mixer is processing timed streaming video (which is typical for most video
sources), the flushing periods coincide with the blanking periods and therefore do not
reduce the throughput of the system.

When operating on a streaming video source (that is, not frame buffered data), the Video
Mixer must operate minimally at the burst data rate. For example, 148.5 MHz for a 1080p60
video source for a one sample per clock configuration of the IP. For a 4K 60 fps video source,
the core must operate at 297 MHz for a two sample per clock configuration, or 148.5 MHz
for a four sample per clock configuration on slower devices such as Artix®-7.

Resource Utilization

For full details about performance and resource utilization, visit the Performance and
Resource Utilization web page.
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Port Descriptions

The Video Mixer uses industry standard control and data interfaces to connect to other
system components. The following sections describe the various interfaces available with
the core. Figure 2-1 illustrates a Video Mixer I/O diagram. In this configuration, the IP has
10 AXI interfaces:

« AXI4-Lite control interface (s_axi_CTRL)
+ AXI4-Stream streaming video output (m_axis_video)
« AXI4-Stream streaming video input (s_axis_video, s_axis_videol, etc.)

«  Memory mapped AXI4 interface (m_axi_mm_video4, m_axi_mm_video5, etc.).

F o
|<ps_axi_CTRL ; , )
. - m_axi_mm_wvideo4 <= }.
= dps_axis_video , _ }
] A m_axi_mm_videoS5 < |
~dps_axis_videol , _ L
= ) m_axi_mm_video6 < }
=4k S_axis_video2 . . »
=] W m_axi_mm_video7 < .-
= <ps_axis_video3 g '
- m_axis_video <p
- ap_clk _

interrupt
ap_rst_n

Figure 2-1: Video Mixer I/O Diagram

Video Mixer v2.0 Send Feedback 9
PG243 October 4, 2017 www.Xilinx.com l—\/—l



https://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=Product_Guide&docId=PG243&Title=Video%20Mixer%20v2.0&releaseVersion=2.0&docPage=9

i: XILINX Chapter 2: Product Specification

ALL PROGRAMMABLE-

The interfaces change depending on the number of layers and layer type, that is, streaming
or memory based. For example, Figure 2-2 shows a minimum configuration of the Video

Mixer IP with only one layer and a logo layer.

s

aps_axi_CTRL

=ars_axis_video m_axis_videoqp =
. |
=ap _clk mterrupt]—

'C[ap_rst_n

"c

'Q:-

Figure 2-2: Video Mixer 1/O Diagram Single Layer

Common Interface Signals

Table 2-1 summarizes the signals which are either shared by, or not part of the dedicated
AXI4-Stream, memory mapped AXI4 data, or AXI4-Lite control interfaces.

Table 2-1: Common Interface Signals

Signal Name 1/0 | Width Description
ap_clk I 1 Video core clock
ap_rst_n I 1 Video core active-Low clock enable
interrupt O 1 Interrupt Request Pin

The ap_clk and ap_rst_n signals are shared between the core, the AXI4-Stream, memory
mapped AXI4 data interfaces, and the AXI4-Lite control interface.

ap_clk

The AXI4-Stream, memory mapped AXI4, and AXI4-Lite interfaces must be synchronous to
the core clock signal ap_c1k. All AXI4-Stream, memory mapped AXI4 interface input
signals and AXI4-Lite control interface input signals are sampled on the rising edge of
ap_clk. All AXI4-Stream output signal changes occur after the rising edge of ap_c1k.

ap_rst_n

The ap_rst_n pin is an active-Low, synchronous reset input pertaining to both AXI4-Lite,
AXI14-Stream, and memory mapped AXI4 interfaces. When ap_rst_n is set to O, the core
resets at the next rising edge of ap_c1k.
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interrupt

The interrupt status output bus can be integrated with an external interrupt controller that
has independent interrupt enable/mask, interrupt clear, and interrupt status registers that
allows for interrupt aggregation to the system processor.

AXl4-Stream Video Interface

The Video Mixer in any configuration has AXI4-Stream video input and output interfaces
named s_axis_video and m_axis_video, respectively. Per additional streaming layer,
there are an additional AXI4-Stream video input named s_axis_videoi with 1
representing the layer number minus 1. All video streaming interfaces follow the interface
specification as defined in the Video IP chapter of the Vivado Design Suite: AXI Reference
Guide (UG1037) [Ref 1]. The video AXI4-Stream interface can be single, dual, or quad pixels
per clock and can support 8, 10, 12, or 16 bits per component. The streaming interface
configuration (samples per clock and bits per component) is chosen at IP level and applies
to all instances of the AXI4-Stream interface.

Table 2-2 through Table 2-6 explain the pixel mapping of an AXI4-Stream interface with 2
pixels per clock and 10 bits per component configuration for all supported color formats.
Given that the Video Mixer always requires a hardware configuration for at least three
component video, the AXI4-Stream Subset Converter is needed to communicate with other
IPs of two or one component video interface in YUV 4:2:2, 4:2:0, or Luma Only.

Table 2-2: Dual Pixels Per Clock, 10 Bits Per Component Mapping for RGB
63:60 59:50 49:40 39:30 29:20 19:10 9:0
Zero padding R1 Bl Gl RO BO GO

Table 2-3: Dual Pixels Per Clock, 10 Bits Per Component Mapping for YUV 4:4:4
63:60 59:50 49:40 39:30 29:20 19:10 9:0
Zero padding V1 Ul Y1l \ uo YO

Table 2-4: Dual Pixels Per Clock, 10 Bits Per Component Mapping for YUV 4:2:2
63:60 59:50 49:40 39:30 29:20 19:10 9:0
Zero padding | Zero padding | Zero padding VO Y1 uo YO

Table 2-5: Dual Pixels Per Clock, 10 Bits Per Component Mapping for RGBA
79:70 69:60 59:50 49:40 39:30 29:20 19:10 9:0
Al R1 Bl Gl A0 RO BO GO

Table 2-6: Dual Pixels Per Clock, 10 Bits Per Component Mapping for YUVA 4:4:4
79:70 69:60 59:50 49:40 39:30 29:20 19:10 9:0
Al V1 Ul Y1l AO VO uo YO
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Table 2-7 shows the interface signals for input and output AXI4-Stream video streaming

interfaces.

Table 2-7: AXl4-Stream Interface Signals

Chapter 2:

Product Specification

Signal Name 1/0 Width Description
. floor((3® x bits_per_component
s_axis_tdata I x pixels_per clock) + 7)/ 8) x 8 Input Data
s_axis_tready @) 1 Input Ready
s_axis_tvalid (0] 1 Input Valid
s_axis_tdest I 1 Input Data Routing Identifier
Input byte qualifier that indicates whether the
s_axis_tkeep I (s_axis_video_tdata width) / 8 | content of the associated byte of TDATA is
processed as part of the data stream.
s_axis_tlast I 1 Input End of Line
Input byte qualifier that indicates whether the
s_axis_tstrb I (s_axis_video_tdata width) / 8 | content of the associated byte of TDATA is
processed as a data byte or a position byte.
s_axis_tuser I 1 Input Start of Frame
. floor(((3 x bits_per_component
m_axis_tdata (0] « pixels_per_clock) + 7)/ 8) x 8 Output Data
m_axis_tdest @) 1 Output Data Routing Identifier
m_axis_tid (0] 1 Output Data Stream Identifier
Output byte qualifier that indicates whether the
m_axis_tkeep (0] (m_axis_video_tdata width) / 8 | content of the associated byte of TDATA is
processed as part of the data stream.
m_axis_tlast (0] 1 Output End of Line
m_axis_tready I 1 Output Ready
Output byte qualifier that indicates whether the
m_axis_tstrb (0] (m_axis_video_tdata width) / 8 | content of the associated byte of TDATA is
processed as a data byte or a position byte.
m_axis_tuser (0] 1 Output Start of Frame
m_axis_tvalid (0] 1 Output Valid
Notes:

1. For RGBA and YUVAA444, the video data consists of 4 components.

All video streaming interfaces run at the IP core clock speed, ap_c1k.
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Memory Mapped AXI4 Interface

Per memory layer, there is a memory mapped AXI4 interface named m_axi_mm_videoi

Chapter 2:

Product Specification

with { representing the layer number minus 1. The memory mapped AXI4 interface runs on
the ap_c1k clock domain. The signals follow the specification as defined in the Vivado
Design Suite: AXI Reference Guide (UG1037) [Ref 1]. Table 2-8 shows the pixel formats in
memory supported by the Video Mixer.

Table 2-8: Pixel Formats

Video Format Description Bits per Component Bytes per Pixel
RGBX8 packed RGB 8 4 bytes per pixel

BGRX8 packed BGR 8 4 bytes per pixel

YUVX8 packed YUV 4:4:4 8 4 bytes per pixel

YUYV8 packed YUV 4:2:2 8 2 bytes per pixel

uyvys packed YUV 4:2:2 8 2 bytes per pixel

RGBAS8 packed RGB with alpha 8 4 bytes per pixel

BGRAS8 packed BGR with alpha 8 4 bytes per pixel

YUVAS8 packed YUV 4:4:4 8 4 bytes per pixel

RGBX10 packed RGB 10 4 bytes per pixel

YUVX10 packed YUV 4:4:4 10 4 bytes per pixel

RGB565 packed RGB 5 bits per R component | 2 bytes per pixel

6 bits per G component
5 bits per B component

Y_UV8 semi-planar YUV 4:2:2 8 1 byte per pixel per plane
Y_UV8_420 semi-planar YUV 4:2:0 8 1 byte per pixel per plane
RGB8 packed RGB 8 3 bytes per pixel

YUV8 packed YUV 4:4:4 8 3 bytes per pixel

Y_UV10 semi-planar YUV 4:2:2 10 4 bytes per 3 pixels per plane
Y_UV10_420 semi-planar YUV 4:2:0 10 4 bytes per 3 pixels per plane
Y8 packed luma only 8 1 byte per pixel

Y10 packed luma only 10 4 bytes per 3 pixels

The following tables explain the expected pixel mappings in memory for each of the

mentioned listed formats.
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RGBX8

Chapter 2:

Product Specification

Packed RGB, 8 bits per component. Every RGB pixel in memory is represented with 32 bits,
as shown. The images need be stored in memory in raster order, that is, top-left pixel first,
bottom-right pixel last. Bits[31:24] do not contain pixel information.

31:24 23:16 15:8 7:0
X B G R
YUVX8

Packed YUV 4:4:4, 8 bits per component. Every YUV 4:4:4 pixel in memory is represented

with 32 bits, as shown. Bits[31:24] do not contain pixel information.

31:24 23:16 15:8 7:0
X v U Y
BGRX8

Packed BGR, 8 bits per component. Every BGR pixel in memory is represented with 32 bits,
as shown. The images need be stored in memory in raster order, that is, top-left pixel first,
bottom-right pixel last. Bits[31:24] do not contain pixel information.

31:24 23:16 15:8 7:0
X R G B
YUYVS8

Packed YUV 4:2:2, 8 bits per component. Every two YUV 4:2:2 pixels in memory are
represented with 32 bits, as shown.

31:24 23:16 15:8 7:0
VO Y1 uo YO
RGBAS8

Packed RGB with alpha, 8 bits per component. Every RGB with alpha pixel is represented

with 32 bits, as shown. Bits[31:24] contain alpha information, 0 is fully transparent, 255 is

fully opaque.
31:24 23:16 15:8 7:0
A B G R
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uyvys

Packed YUV 4:2:2, 8 bits per component. Every two YUV 4:2:2 pixels in memory are
represented with 32 bits, as shown:

31:24 23:16 15:8 7:0
Y1 VO YO uo
BGRAS

Packed BGR with alpha, 8 bits per component. Every BGR with alpha pixel is represented
with 32 bits, as shown. Bits[31:24] contain alpha information, 0 is fully transparent, 255 is
fully opaque.

31:24 23:16 15:8 7:0
A R G B
YUVAS8

Packed YUV with alpha, 8 bits per component. Every YUV 4:4:4 with alpha pixel is
represented with 32 bits, as shown. Bits[31:24] contain alpha information, 0 is fully
transparent, 255 is fully opaque.

31:24 23:16 15:8 7:0
A \Y U Y
RGBX10

Packed RGB, 10 bits per component. Every RGB pixel is represented with 32 bits, as shown.
Bits[31:30] do not contain any pixel information.

31:30 29:20 19:10 9:0
X B G R
YUVX10

Packed YUV 4:4:4, 10 bits per component. Every YUV 4:4:4 pixel is represented with 32 bits,
as shown. Bits[31:30] do not contain any pixel information.

31:30

29:20

19:10

9:0

X

\

u

Y
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RGB565

Packed RGB with 5 bits per R component, 6 bits per G component, 5 bits per B component.
Every RGB pixel is represented with 16 bits, as shown.

15:11 10:5 4:0
B G R

Y _Uvs

Semi-planar YUV 4:2:2 with 8 bits per component. Y and UV stored in separate planes as

shown. The UV plane is assumed to have an offset of stride x height bytes from the Y plane
buffer address.

31:24 23:16 15:8 7:0
Y3 Y2 Y1l YO
31:24 23:16 15:8 7:0
V2 u2 VO uo
Y _UV8_420

Semi-planar YUV 4:2:0 with 8 bits per component. Y and UV stored in separate planes as
shown. The UV plane is assumed to have an offset of stride x height bytes from the Y plane
buffer address.

31:24 23:16 15:8 7:0

Y3 Y2 Y1l YO

31:24 23:16 15:8 7:0

V4 U4 VO uo
RGBS8

Packed RGB, 8 bits per component. Every RGB pixel in memory is represented with 24 bits,
as shown. The images need be stored in memory in raster order, that is, top-left pixel first,
bottom-right pixel last.

23:16

15:8

7:0

B

G
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YUVS

Packed YUV 4:4:4, 8 bits per component. Every YUV 4:4:4 pixel in memory is represented
with 24 bits, as shown. The images need be stored in memory in raster order, that is, top-left
pixel first, bottom-right pixel last.

23:16 15:8 7:0
V U Y
Y UV10

Semi-planar YUV 4:2:2 with 10 bits per component. Every 3 pixels is represented with 32
bits. Bits[31:30] do not contain any pixel information. Y and UV stored in separate planes as
shown. The UV plane is assumed to have an offset of stride x height bytes from the Y plane

buffer address.

63:62 61:52 51:42 41:32 31:30 29:20 19:10 9:0
X Y5 Y4 Y3 X Y2 Y1l YO
63:62 61:52 51:42 41:32 31:30 29:20 19:10 9:0
X V4 U4 V2 X u2 VO uo
Y _UV10_420

Semi-planar YUV 4:2:0 with 10 bits per component. Every 3 pixels is represented with 32
bits. Bits[31:30] do not contain any pixel information. Y and UV stored in separate planes as
shown. The UV plane is assumed to have an offset of stride x height bytes from the Y plane

buffer address.

63:62 61:52 51:42 41:32 31:30 29:20 19:10 9:0
X Y5 Y4 Y3 X Y2 Y1 YO
63:62 61:52 51:42 41:32 31:30 29:20 19:10 9:0
X V8 us V4 X U4 VO uo

Y8

Packed Luma-Only, 8 bits per component. Every luma-only pixel in memory is represented
with 8 bits, as shown. The images need be stored in memory in raster order, that is, top-left
pixel first, bottom-right pixel last. Y8 is presented as YUV 4:4:4 on the AXI4-Stream

interface.

7:0
Y
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Y10

Packed Luma-Only, 10 bits per component. Every three luma-only pixels in memory is
represented with 32 bits, as shown. The images need be stored in memory in raster order,
that is, top-left pixel first, bottom-right pixel last. Y10 is presented as YUV 4:4:4 on the
AXI14-Stream interface.

31:30 29:20 19:10 9:0
X Y2 Y1 YO

AXl4-Lite Control Interface

The AXI4-Lite interface allows you to dynamically control parameters within the core. The
configuration can be accomplished using an AXI4-Lite master state machine, an embedded
ARM®, or soft system processor such as MicroBlaze™. The Video Mixer can be controlled
through the AXI4-Lite interface by using functions provided by the driver in the SDK.
Another method is performing read and write transactions to the register space but should
only be used when the first method is not available. Table 2-9 shows the AXI4-Lite control
interface signals. This interface runs at the ap_c1k clock.

Table 2-9: AXl4-Lite Control Interface Signals

Signal Name 1/0 Width Description
s_axi_ctrl_aresetn I 1 Reset
s_axi_ctrl_aclk I 1 Clock
s_axi_ctrl_awaddr I 18 Write Address
s_axi_ctrl_awprot I 3 Write Address Protection
s_axi_ctrl_awvalid I 1 Write Address Valid
s_axi_ctrl_awready (0] 1 Write Address Ready
s_axi_ctrl_wdata I 32 Write Data
s_axi_ctrl_wstrb I 4 Write Data Strobe
s_axi_ctrl_wvalid I 1 Write Data Valid
s_axi_ctrl_wready (0] 1 Write Data Ready
s_axi_ctrl_bresp (0] 2 Write Response
s_axi_ctrl_bvalid (0] 1 Write Response Valid
s_axi_ctrl_bready I 1 Write Response Ready
s_axi_ctrl_araddr I 18 Read Address
s_axi_ctrl_arprot I 3 Read Address Protection
s_axi_ctrl_arvalid I 1 Read Address Valid
s_axi_ctrl_aready (@] 1 Read Address Ready
s_axi_ctrl_rdata (0] 32 Read Data
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Table 2-9: AXl4-Lite Control Interface Signals (Cont’d)

Signal Name 1/0 Width Description
s_axi_ctrl_rresp (0] 2 Read Data Response
s_axi_ctrl_rvalid (0] 1 Read Data Valid
s_axi_ctrl_rready I 1 Read Data Ready

Register Space

The Video Mixer has specific registers which allow you to dynamically control the operation
of the core. All registers have an initial value of 0.

Top-Level Registers
Table 2-10 provides a detailed description of all the registers that apply globally to the IP.

Table 2-10: Top-Level Registers

Address (hex) . Access . .
BASEADDR+ Register Name Type Register Description
Bit[0] = ap_start
Bit[1] = ap_done
Bit[2] = ap_idle
0x0000 Control R/W
X ontro / Bit[3] = ap_ready
Bit[7] = auto_restart
Others = Reserved
Bi = Global i I
0x0004 Global Interrupt Enable | R/W 1t[0] = Global interrupt enable

Others = Reserved

Bit[0] = Channel 0 (ap_done)
0x0008 IP Interrupt Enable Bit[1] = Channel 1 (ap_ready)
Others = reserved

Bit[0] = Channel 0 (ap_done)

IP Interrupt Status

0x000C Register R/TOW® | Bit[1] = Channel 1 (ap_ready)

Others = Reserved
0x0010 Width R/W Active width of background.
0x0018 Height R/W Active height of background.
0x0028 Background_Y_R R/W Red or Y value of background color
0x0030 Background_U_G R/W Green or U value of background color
0x0038 Background_V_B R/W Blue or V value of background color
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Table 2-10: Top-Level Registers (Cont’d)

Address (hex) . Access . A
BASEADDR+ Register Name Type Register Description
Bit[0] = Master layer is enabled/disabled
Bit[1] = Layer 1 is enabled/disabled
0x0040 Layer enable R/W
Bit[7] = Layer 7 is enabled/disabled
Bit[8] = Logo layer is enable/disabled
Notes:

1. TOW = Toggle on Write.

Video Mixer v2.0

Control (0x0000) Register

This register controls the operation of the Video Mixer. Bit[0] of the Control register,
ap_start, kicks off the core from software. Writing 1 to this bit, starts the core to generate
a video frame. To set the core in free running mode, Bit[7] of this register, auto_restart,
must be set to 1. Bits[3:1] are not used now but reserved for future use.

Global Interrupt Enable (0x0004) Register

This register is the master control for all interrupts. Bit[0] can be used to enable/disable all
core interrupts.

IP Interrupt Enable (0x0008) Register

This register allows interrupts to be enabled selectively. Currently, two interrupt sources are
available ap_done and ap_ready. ap_done is triggered after the frame processing is
complete, while ap_ready is triggered after the core is ready to start processing the next
frame.

IP Interrupt Status (0x000C) Register

This is a dual purpose register. When an interrupt occurs, the corresponding interrupt
source bit is set in this register. In readback mode (Get status), the interrupting source can
be determined. In writeback mode (Clear interrupt), the requested interrupt source bit is
cleared.

Width (0x0010) Register

The WIDTH register encodes the number of active pixels per scan. Supported values are
between 64 and the value provided in the Maximum Number of Columns field in the
Vivado Integrated Design Environment (IDE). To avoid processing errors, you should restrict
values written to width to the range supported by the core instance. Furthermore, width
needs to be a multiple of the Samples per Clock field in the Vivado IDE.
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Height (0x0018) Register

The Height register encodes the number of active scan lines per frame. Supported values
are between 64 and the value provided in the Maximum Number of Rows field in the
Vivado IDE. To avoid processing errors, you should restrict values written to height to the
range supported by the core instance.

Background_Y_R (0x0028) Register

Red color component of the background color. The range of the background color is
determined by the number of bits per color component selected in the Maximum Data
Width field in the Vivado IDE, for example, 0..1023 for 10-bit maximum data width.

Background_U_G (0x0030) Register

Green color component of the background color. The range of the background color is
determined by the number of bits per color component selected in the Maximum Data
Width field in the Vivado IDE, for example, 0..1023 for 10-bit maximum data width.

Background_V_B (0x0038) Register

Blue color component of the background color. The range of the background color is
determined by the number of bits per color component selected in the Maximum Data
Width field in the Vivado IDE, for example, 0..1023 for 10-bit maximum data width.

Layer Enable (0x0040) Register

This register has one bit for every layer that indicates whether a layer is enabled (1) or
disabled (0). Bit[0] is for the master input layer, which associates with the s_axis_video
AXI4-Stream input. This is the bottom-most layer, and all other layers are blended on top.
If this layer is disabled and no other layers are blended on top, the background color as
specified by the previous mentioned registers are shown.

Bit[1] is for layer 1, which associates with either s_axis_videol AXI4-Stream input or
m_axi_mm_videol memory mapped AXI4 input, depending on the Interface Type field
selected in the Vivado IDE. Bit[2] is for layer 2, and so on, until Bit[7] which enables/disables
layer 7.

Bit[8] is for the logo layer. The logo layer is the top-most layer and is blended on top of all
other layers.
Layer Registers

Table 2-11 provides a detailed description of all the registers that apply to layers 1 through
7. Note that layer 1 registers start at base address 0x0200, layer 2 registers start at base
address 0x300, and so forth.
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Table 2-11: Layer Registers

Address (hex)
BASEADDR+

Access

Register Name Type

Description

Alpha blending value for layer 1 ranging from
0x0200 Layer 1 Alpha R/W 0 = Fully transparent
256 = Fully opaque

X position of the top left corner of layer 1, relative to the

0x0208 Layer 1 Start X R/W background layer
0x0210 Layer 1 Start Y R/W Y position of the top left corner of layer 1, relative to the
background layer
0x0218 Layer 1 Width R/W Active width (in pixels) of layer 1
0x0220 Layer 1 Stride R/W Active stride (in bytes) of layer 1
0x0228 Layer 1 Height R/W Active height (in lines) of layer 1
Scale factor for layer 1 ranging from
=N li
0x0230 Layer 1 Scale Factor R/W 0 © scallng . .
1 = 2x scaling (horizontally and vertically)
2 = 4x scaling (horizontally and vertically)
0x0240 Layer 1 Plane 1 Buffer | R/W Start address of plane 1 of frame buffer for layer 1. Only valid

in case layer 1 is a memory layer.

Start address of plane 2 of frame buffer for layer 1. Only valid
0x024C Layer 1 Plane 2 Buffer | R/W in case layer 1 is a memory layer and a semi-planar video
format is selected.

Layer Alpha (0x0*00) Register

The Layer Alpha register specifies the per layer alpha blending value used for blending this
layer with the underlying layer. The value of this register has a range from 0 which is fully
transparent, to 256 which is fully opaque. Layer alpha blending is only supported when the
Enable Global Alpha field in the Vivado IDE is enabled for a particular layer. When alpha
blending is disabled for a layer, layers are blended as fully opaque on top of the underlying
layer.

Layer Start X (0x0*08) Register

The Layer Start X register marks the x position (columns) of the top left corner of the layer
relative to the mixer output frame dimensions. (0,0) puts the layer in the top left corner of
the output frame. To avoid processing errors, you should restrict values written to start x
such that the entire layer is contained within the frame. Furthermore, the x position needs
to be a multiple of the Samples per Clock field in the Vivado IDE.

Video Mixer v2.0 Send Feedback 22
PG243 October 4, 2017 www.Xilinx.com [—\/—]



https://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=Product_Guide&docId=PG243&Title=Video%20Mixer%20v2.0&releaseVersion=2.0&docPage=22

g: XILINX Chapter 2: Product Specification

ALL PROGRAMMABLE

Layer Start Y (0x0*10) Register

The Layer Start Y register marks the y position (rows) of the top left corner of the layer
relative to the mixer output frame dimensions. (0,0) puts the layer in the top left corner of
the output frame. To avoid processing errors, you should restrict values written to start 'y
such that the entire layer is contained within the frame.

Layer Width (0x0*18) Register

The Layer Width register encodes the active width in pixels of the layer. Supported values
are between 64 and the value provided in the Maximum Number of Columns field in the
Vivado IDE if the Enable Scaling field in the Vivado IDE is disabled. It is between 64 and the
Layer Line Buffer Width in the Vivado IDE if the Enable Scaling field is enabled. To avoid
processing errors, you should restrict values written to layer width such that the entire layer
is contained within the frame. Furthermore, layer width needs to be a multiple of the
Samples Per Clock field in the Vivado IDE.

Layer Stride (0x0*20) Register

This register is not applicable if the layer is a streaming layer. If it is a memory layer, the
layer stride determines the number of bytes from one row of pixels in memory to the next
row of pixels in memory. When a video frame is stored in memory, the memory buffer might
contain extra padding bytes after each row of pixels. The padding bytes only affect how the
image is stored in memory, but does not affect how the image is displayed.

Padding bytes is necessary to make sure that every row of pixels starts at an address that is
aligned with the size of the data on the memory mapped AXI4 interface. Therefore, layer
stride needs to be a multiple of the memory mapped AXI4 data size. For the Video Mixer,
the data size of the memory mapped AXI4 interface is 64 x Samples per Clock bits, that is,
64, 128, or 256 bits for 1, 2, and 4 samples per clock, respectively.

Layer Height (0x0*28) Register

The Layer Height register encodes the height in lines of the layer. Supported values are
between 64 and the value provided in the Maximum Number of Rows field in the Vivado
IDE. To avoid processing errors, you should restrict values written to layer height such that
the entire layer, after applying the scale factor, is contained within the frame.
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Layer Scale Factor (0x0*30) Register

The Layer Scale Factor register determines the scaling factor that is applied before blending
this layer with the underlying layer. Scale factors of 1x, 2x, and 4x are supported.

+ 0 = No scaling
« 1 = 2x scaling (horizontally and vertically)

» 2 = 4x scaling (horizontally and vertically)

Layer scaling is only supported when the Enable Scaling field in the Vivado IDE is enabled
for a particular layer.

Layer Buffer Plane 1 (0x0*40) and Layer Plane 2 Buffer (0x0*4C) Registers

In case the layer is a memory layer, the Layer Plane 1 Buffer register specifies the frame
buffer address of plane 1. Note that for the semi-planar formats (Y_UV8, Y_UV8_420,
Y_UV10, and Y_UV10_420), the chroma buffer is specified by the Layer Plane 2 Buffer
register. The addresses must be aligned to the data size of the memory mapped AX14
interface. For the Video Mixer, the data size of the memory mapped AXI4 interface is 64 x
Samples per Clock bits, that is, 64, 128, or 256 bits for 1, 2, and 4 samples per clock,
respectively. These registers are not applicable when the layer is a streaming layer.

Logo Layer Registers
Table 2-12 provides a detailed description of all the registers that apply to the logo layer.

Table 2-12: Logo Layer Registers

Address (hex) . Access A
BASEADDR+ Register Name Type Description

0x1000 Logo Start X R/W X position of the top left corner of the logo, relative to the
output resolution

0x1008 Logo Start ¥ R/W Y position of the top left corner of the logo, relative to the
output resolution

0x1010 Logo Width R/W Active width (in pixels) of the logo

0x1018 Logo Height R/W Active height (in lines) of the logo
Scale factor for logo ranging from
0=N li

0x1020 Logo Scale Factor R/W © scaling

1 = 2x scaling (horizontally and vertically)
2 = 4x scaling (horizontally and vertically)

Alpha blending value for logo ranging from
0x1028 Logo Alpha R/W 0 = Fully transparent
255 = Fully opaque

0x1030 Logo Color Key Min R | R/W Red minimum value of color key range

0x1038 Logo Color Key Min G | R/W Green minimum value of color key range
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Table 2-12: Logo Layer Registers (Cont’d)

A;:;SZ%(;S:_() Register Name A;;::s Description

0x1040 Logo Color Key Min B | R/W Blue minimum value of color key range
0x1048 Logo Color Key Max R | R/W Red maximum value of color key range
0x1050 Logo Color Key Max G | R/W Green maximum value of color key range
0x1058 Logo Color Key Max B | R/W Blue maximum value of color key range

0x1 0000 Logo Red Buffer R/W Start address of buffer for red logo pixels

0x2 0000 Logo Green Buffer R/W Start address of buffer for green logo pixels
0x3 0000 Logo Blue Buffer R/W Start address of buffer for blue logo pixels
0x4 0000 Logo Alpha Buffer R/W Start address of buffer for logo per pixel alpha

Video Mixer v2.0

Logo Start X (0x1000) Register

The Logo Start X register marks the x position (columns) of top left corner of the logo
relative to the mixer output frame dimensions. (0,0) puts the logo in the top left corner of
the output frame. To avoid processing errors, you should restrict values written to start x
such that the entire logo is contained within the frame. Furthermore, the x position needs to
be a multiple of the Samples per Clock field in the Vivado IDE.

Logo Start Y (0x1008) Register

The Logo Start Y register marks the y position (rows) of the top left corner of the logo
relative to the mixer output frame dimensions. (0,0) puts the logo in the top left corner of
the output frame. To avoid processing errors, you should restrict values written to start 'y
such that the entire logo is contained within the frame.

Logo Width (0x1010) Register

The Logo Width register encodes the width in pixels of the logo. Supported values are
between 32 and the value provided in the Maximum Number of Columns for Logo field
in the Vivado IDE. To avoid processing errors, you should restrict values written to width to
the range supported by the core instance. Furthermore, width needs to be a multiple of the
Samples per Clock field in the Vivado IDE.

Logo Height (0x1018) Register

The Logo Height register encodes the height in lines of the logo. Supported values are
between 32 and the value provided in the Maximum Number of Rows for Logo field in
the Vivado IDE. To avoid processing errors, you should restrict values written to height to
the range supported by the core instance.
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Logo Scale Factor (0x1020) Register

The Logo Scale Factor register determines the scaling factor that is applied before blending
the logo with the underlying layer. Scale factors of 1x, 2x, and 4x are supported.

+ 0 = No scaling
« 1 = 2x scaling (horizontally and vertically)

» 2 = 4x scaling (horizontally and vertically)

Logo Alpha (0x1028) Register

The Logo Alpha register specifies the per layer alpha blending value used for blending the
logo with the underlying layer. The value of this register has a range from 0 which is fully
transparent, to 256 which is fully opaque.

Logo Color Key Min R (0x1030) Register

The Logo Color Key values determine a color range that is treated as transparent. Any logo
pixel that falls in this range are not blended on top of the underlying layer but is
transparent. This equation is used to determine if a pixel is transparent.

Let (r, g, b) be a pixel value of the logo.
Let (min_r, min_g, min_b) and (max_r, max_g, max_b) be the values of the Color Key registers.
Then, pixel (r, g, b) is transparent if the following holds:

min_r < r < max_r AND

min_g < g < max_g AND

min_b < b < max_b

To turn off background color keying, program a maximum value that is smaller than the
minimum value, for example, maximum is 0, minimum is 1.

Logo Color Key Min G (0x1038)

For more information, see Logo Color Key Min R (0x1030) Register.

Register, Logo Color Key Min B (0x1040) Register

For more information, see Logo Color Key Min R (0x1030) Register.
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Logo Color Key Max R (0x1048) Register

For more information, see Logo Color Key Min R (0x1030) Register.

Logo Color Key Max G (0x1050) Register

For more information, see Logo Color Key Min R (0x1030) Register.

Logo Color Key Max B (0x1058) Register

For more information, see Logo Color Key Min R (0x1030) Register.

Logo Red Buffer (0x1 0000) Register

The memory for storing the frame data for the logo layer is block RAM local to the core. The
application is required to load the logo into this block RAM through the AXI4-Lite interface.
The Logo Buffer address is the start address for this block RAM.

The Logo Buffer addresses point to block RAM for separate red, green, and blue pixel
buffers that hold the logo pixels. Optionally, if Logo Per Pixel Alpha is enabled, there is an
additional buffer for the logo per pixel alpha values. The logo has to be formatted as planar
RGB(A) with eight bits per color component. The size of the buffer is dimensioned by the
Maximum Number of Columns for Logo and the Maximum Number of Rows for Logo
fields in the Vivado IDE. With eight bits per color component, the size in bytes is defined as
columns x rows. The logo pixels have to be organized in the buffer as follows.

« Red[x + y x columns] holds the red pixel of the logo for column x and row y
« Green[x + y x columns] holds the green pixel of the logo for column x and row y
« Blue[x + y x columns] holds the blue pixel of the logo for column x and row y

« Alphalx + y x columns] holds the per pixel alpha value of the logo for column x and
row y

Logo Green Buffer (0x2 0000) Register

For more information, see Logo Red Buffer (Ox1 0000) Register.

Logo Blue Buffer (0x3 0000) Register

For more information, see Logo Red Buffer (Ox1 0000) Register.

Logo Alpha Buffer (0x4 0000) Register

For more information, see Logo Red Buffer (Ox1 0000) Register.
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Designing with the Core

Chapter 3

This chapter includes guidelines and additional information to facilitate designing with the

core.

General Design Guidelines

The Video Mixer has support for up to eight layers, with an optional logo layer, using a
combination of video inputs from either frame buffer (through memory-mapped AXI4
interfaces) or streaming video cores (through AXI4-Stream interfaces). Figure 3-1 shows the
functional block diagram of the Video Mixer. Functions listed as optional are under Vivado®

Integrated Design Environment (IDE) control, as explained later in this section.

. Optional Optional
Main Layer AXI4- 420-422-444 YUV to RGB
Stream input . N
Resampling Conversion
Y
Layer 1 AXI4- . .
Optional Optional . .
Stream or 420-422-444 YUV to RGB Optional Scaling Mix
Memory Mapped Resamplin Conversion (2x.4%)
AXI4 Input ping
Layer 2 AXI4- . .
Optional Optional . .
Stream or 420-420-444 YUV to RGB Optional Scaling Mix
Memory Mapped Resamplin Conversion (2. 4%)
AXI4 Input ping
Layer 7 AX14- N .
Optional Optional . .
Stream or 420-422-444 YUV to RGB Optional Scaling Mix
Memory Mapped Resamplin Conversion (2%, 4%)
AXI4 Input piing
. . Optional Optional
Logo in Block - Scaling Mix RGB to YUV 444-422-420 AXI4-Stream
RAM (1x, 2x, 4x) . . Output
Conversion Resampling

X16244-080216

Figure 3-1: Video Mixer Customize IP

The Video Mixer always has one streaming input layer and one streaming output layer. This
is known as main, master, or background layer. The main layer associates with the
s_axis_video AXI4-Stream input and m_axis_video AXI4-Stream output.
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The main layer input is the bottom-most layer and all other layers are blended on top. Note
that there is no programmable Z order for layers. The main layer can be disabled at
run-time through the AXI4-Lite interface, by clearing Bit[0] of the Layer Enable (0x0040)
Register. When disabled, the main layer does not read from the streaming interface but
generates a solid background color as specified by Background_Y_R (0x0028) Register,
Background_U_G (0x0030) Register, and Background_V_B (0x0038) Register.

The video format of both the streaming input and output layer is determined by the Video
Format field in the Vivado IDE. As video mixing is performed in the RGB domain, note that
if the selected video format is YUV 4:4:4, color space conversion is done at the input to RGB,
and at the output to go back to YUV 4:4:4 again. If the selected video format is YUV 4:2:2 or
YUV 4:2:0, additional chroma resampling at the input and output is performed to go from
YUV 4:2:2 (or YUV 4:2:0) to YUV 4:4:4 and back.

The Video Mixer can have up to seven additional video or graphics sources, each of which
can be configured to be an AXI4-Stream or memory mapped AXI4 frame buffer. When using
streaming layers, keep in mind that the Video Mixer achieves synchronization of streaming
layers to the main output layer by throttling the incoming data if the mixer is not ready to
accept this data yet. Also, the mixer has no internal buffering to queue up incoming data.

If a memory mapped AXI4 frame buffer is selected to be a source, then the Video Mixer
automatically handles interfacing to memory without the need of an additional AXI VDMA
controller.

Like the main layer, every layer has a pre-defined video format that is either RGB, YUV 4:4:4,
YUV 4:2:2, or YUV 4:2:0. Optional chroma resampling from YUV 4:2:2, or YUV 4:2:0 to YUV
4:4:4, and optional color space conversion from YUV 4:4:4 to RGB, are performed as mixing
is done in the RGB domain. Layers 1 through 7, additionally can be configured to optionally
have scaling ability (1x, 2x, or 4x) by the Enable Scaling field in the Vivado IDE. Scaling is
implemented by means of pixel and line repeat, and therefore requires an internal line
buffer.

The Video Mixer provides an optional logo layer. It blends a logo that is stored in the block
RAM on the top-most layer. A programmable color key can be used to make part of the logo
transparent. Also, (per pixel) alpha-blending can be used for logo transparency. The logo

layer also has the ability for scaling (1x, 2x, or 4x). As the logo is read from the block RAM,
no additional line buffer is needed for this. Scaling is implemented by means of pixel and

line repeat.

Alpha Blending

Alpha blending is the process of combining two images with the appearance of partial
transparency. To perform this composition, a per layer alpha value (and optionally a per
pixel alpha value) is used that contains the coverage information for all the pixels within a
layer. The alpha value ranges from 0 to 1, where 0 represents that the current pixel does not
contribute to the final image and is fully transparent. A 1 represents that the current pixel
is fully opaque. Any value in between represents a partially transparent pixel.
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When applying alpha blending, the two pixels to be blended reside within two different
image layers. Each layer has a definite Z-axis order. In other words, each layer resides closer
or farther from the observer and has a different depth. Thus, the image pixel and the image
pixel directly "over" it are to be blended.

The equation for alpha blending one layer to the layer directly behind in the Z-axis is below.
This operation is conceptually simple linear interpolation between each color component of
each layer.

Component'(, \, ,y = aComponent +(1-a)Component, \, ,_1)

(x,¥,2)

Where:

a is the product of the global alpha and per pixel alpha (if enabled) or just the global
alpha value (otherwise).

Component,, ,, , represents one color component channel from the color space triplet
(RGB, YUV, etc.) associated with the pixel at coordinates (x, y) in Layer z.

Component, ,, ,_1)represents the same color component at the same (x, y) coordinates
in Layer z— 1 (one layer below in Z-plane order).

Component'y, , , is the resulting output component value after alpha-blending the
component values from coordinates (x, y) from Layer z and Layer z — 1.

The same equation applies for the next layer above, Layer z + 1. These alpha-blending
operations can be chained together by taking the resultant output, Component'(, ,, ,, and
substituting it into the Layer z + 1 equation for Component, ,, ,. This implies that the result
of blending Layer z with the background becomes the new background for Layer z + 1, or
the layer directly over it. In this mode, any number of image layers can be blended by taking
the blended result of the layer below it.

Note: Alpha blending is optional per layer but always enabled for the logo layer. In case alpha
blending is disabled, pixels are always superimposed as fully opaque on the underlying layer.

Clocking

The Video Mixer has only one clock domain. All interfaces, that is, master and slave
AXI4-Stream video interfaces as well as the AXI4-Lite interface, and also the memory
mapped AXI4 interfaces uses the ap_c1k pin as its clock source.
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Pixel throughput of the Video Mixer core is defined by the product of the clock frequency
times the Samples per Clock setting in the Vivado IDE. With a clock frequency of 300 MHz
for ap_clk, and a two sample per clock configuration, the Video Mixer is capable of a 600
mega pixel throughput rate, which is sufficient to handle 4K resolutions at 60Hz.

Resets

The Video Mixer has only a hardware reset option, ap_rst_n pin. No software reset option
is available. The external reset pulse needs to be held for 16 or more ap_c1k cycles to reset
the core. The ap_rst_n signal is synchronous to the ap_c1k clock domain. The ap_rst_n
signal resets the entire core including the AXI4-Lite, AXI4-Stream, and memory mapped
AXI4 interfaces.

System Considerations

The Video Mixer must be configured for the actual input and output image frame-size to

operate properly. To gather the frame size information from the image video stream, it can
be connected to the Video In to AXI4-Stream input and the Video Timing Controller. The

timing detector logic in the Video Timing Controller gathers the video timing signals. The
AXI4-Lite control interface on the Video Timing Controller allows the system processor to
read out the measured frame dimensions, and program all downstream cores, such as the
Video Mixer, with the appropriate image dimensions.

Another system consideration that needs to be taken into account is that there is sufficient
bandwidth available to the Video Mixer to maintain proper functioning memory layers. The
bandwidth needed (in MB/s) for a memory layer can be calculated with the following
equation:

Bandwidth (MB/s) = fps x height x stride

Where fps is the number of frames per second the Video Mixer is operating at, height is the
height in lines of the layer, and stride is the stride in bytes of the layer.

Programming Sequence

Most Video Mixer processing parameters other than image sizes can be changed
dynamically and the change is picked up immediately. If the image size needs to be
changed or the entire system needs to be restarted, it is recommended that pipelined Xilinx
IP video cores are disabled/reset from system output towards the system input, and
programmed/enabled from system output to system input.
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Chapter 4

Design Flow Steps

This chapter describes customizing and generating the core, constraining the core, and the
simulation, synthesis and implementation steps that are specific to this IP core. More
detailed information about the standard Vivado® design flows and the IP integrator can be
found in the following Vivado Design Suite user guides:

» Vivado Design Suite User Guide: Designing IP Subsystems using IP Integrator (UG994)
[Ref 2]

« Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 3]
« Vivado Design Suite User Guide: Getting Started (UG910) [Ref 4]
« Vivado Design Suite User Guide: Logic Simulation (UG900) [Ref 5]

Customizing and Generating the Core

This section includes information about using Xilinx tools to customize and generate the
core in the Vivado Design Suite.

If you are customizing and generating the core in the Vivado IP integrator, see the Vivado
Design Suite User Guide: Designing IP Subsystems using IP Integrator (UG994) [Ref 2] for
detailed information. IP integrator might auto-compute certain configuration values when
validating or generating the design. To check whether the values do change, see the
description of the parameter in this chapter. To view the parameter value, run the
validate_bd_design command in the Tcl console.

You can customize the IP for use in your design by specifying values for the various
parameters associated with the IP core using the following steps:

1. Select the IP from the Vivado IP catalog.

2. Double-click the selected IP or select the Customize IP command from the toolbar or
right-click menu.

For details, see the Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 3] and
the Vivado Design Suite User Guide: Getting Started (UG910) [Ref 4].

Note: Figure in this chapter is an illustration of the Vivado Integrated Design Environment (IDE). The
layout depicted here might vary from the current version.
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Interface

The Video Mixer is configured to meet your specific needs through the Vivado Design
Suite. This section provides a quick reference to parameters that can be configured at
generation time.

Figure 4-1 shows the Video Mixer Vivado IDE main configuration screen.

Re-customize IP

Video Mixer (2.0) ‘
o Documentation IP Location
Show disablad ports Component Name | v_mix_0
Streaming Video Format RGEB w
Samples per Clock 2 w
Maximum Data Width 10 A
Mumber of Layers 8 w
Maximum MNumber of Columns 3840 [64 - 4096
Maximum Mumber of Rows 2160 [64 - 2160]
Address Width 32 ~
Lavar D Video Enable Enable Line Buffer Interface
= Format Global Alpha Scaling Wicth Type
m_axi_mm_video2 4 1 RGCE - 7 Stream -
T A m_axi_mm_video3 < T T
= S " m_axi_mm_videad 4| 2 RGBXE > Memiary i
S s_axiz_video + &
=4 s_axis_videol m,axw,mm,\f!ueos ks 3 UYvYe - 7 1920 Memaory -
i m_axi_mm_video& & |- |
fReE m_axi_mm _wideo? o[- 4 RGBXE8 ' Memary -
ap_rsi_n ot
m_axis_video 4=
interrupt 3 Y10 ¥ | Memory 7
& vy e ¥ ¥y Memary -
7 YUYVE - ¥ 1920 Memaory -

+| Enable Logo Layer

Logo Control

Maximum Number of Columns for Logo | 64

Maximum Number of Rows for Logo &4
Enable Logo Transparency Colar

Enable Logo per Pixel Alpha

oK

Bought IF license availabla ‘ | Cancel

Figure 4-1: Video Mixer Customize IP
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General Settings
The following settings are generally applicable:

« Component Name - The component name is used as the base name of output files
generated for the module. Names must begin with a letter and must be composed
from characters:atoz, Oto9and "_"

« Streaming Video Format - Specifies the video format on the streaming input
(s_axis_video) and output (m_axis_video) AXI4-Stream interfaces. Possible
formats are RGB, YUV 4:4:4, YUV 4:2:2, or YUV 4:2:0.

Note: The video format is chosen at build time and cannot be changed at run-time.

« Samples Per Clock - Specifies the number of pixels processed per clock cycle.
Permitted values are one, two, and four samples per clock. This parameter determines
the IP throughput. The more samples per clock, the larger throughput it provides. The
larger throughput always needs more hardware resources.

Note: This property applies to all layers that have a streaming interface.

« Maximum Data Width — Specifies the bit width of input and output samples on all the
streaming interfaces. Permitted values are 8, 10, 12, and 16 bits.

Note: This property applies to all layers that have a streaming interface.

«  Maximum Number of Columns — Specifies maximum active video columns/pixels the
IP core could produce at run-time. Any video width that is less than the Maximum
Number of Columns can be programmed through AXI4-Lite control interface without
regenerating the core.

+ Maximum Number of Rows — Specifies maximum active video rows/lines the IP core
could produce at run-time. Any video height that is less than Maximum Number of
Rows can be programmed through the AXI4-Lite control interface without
regenerating the core.

« Address Width - Specifies the address width of the AXI master interfaces for memory
layers, either 32 or 64 bits.

*  Number of Layers — Specifies the number of layers with a minimum of one and a
maximum of eight. When only one layer is selected, the logo layer is enabled by
default, and the Video Mixer is essentially just a logo overlay function.

Layer Settings
The following settings apply to optional layers with ID 1 through 7.

« Layer ID - Identifies the layer ID.

« Video Format - Specifies the video format per layer. Possible formats are RGB, YUV
4:4:4, YUV 4:2:2, or YUV 4:2:0, RGBA, and YUVA444 in case the layer interface type is
streaming, and RGBX8, BGRX8, YUVX8, RGBAS, BGRAS8, YUVAS, YUYVS, UYVYS8, RGBX10,
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YUVX10, RGB565, Y _UVS8, and Y_UV8 420, RGBS, YUV8,Y_UV10, Y_UV10 420, Y8, Y10,
otherwise.

Note: The video format is chosen at build time and cannot be changed at run-time.

Enable Global Alpha — When selected, this enables alpha blending for this layer with
the layer underneath. The alpha value needs to be programmed at run-time through
the AXI4-Lite control interface.

Note: If any of the per pixel alpha formats are selected for a layer, then the global alpha is
automatically enabled.

Enable Scaling — When selected, this enables scaling for this layer. The scale factor (1x,
2x, or 4x) needs to be programmed at run-time through the AXI4-Lite control interface.

Line Buffer Width — This is only enabled when scaling is enabled for a layer and
specifies the maximum width of this layer before scaling. A line buffer with this
dimension is allocated in the block RAM to allow for scaling through line repeat. The
width needs to be a multiple of the samples per clock setting.

Interface Type — Determines whether a layer is either a memory layer or a streaming
layer. A memory layer has a memory mapped AXI4 interface while a streaming layer has
an AXI4-Stream interface.

Logo Layer Settings

The following settings apply to the optional logo layer.

Enable Logo Layer - When selected, this includes the logo layer. Block RAM is used for
pixel storage of the logo according to the dimension settings. The logo is limited to
eight bits per color component, and always needs to be formatted as RGB.

Maximum Number of Columns for Logo - Specifies maximum pixel width of the logo.
The width needs to be a multiple of the samples per clock setting. This setting affects
the block RAM utilization.

Maximum Number of Rows for Logo — Specifies maximum line height of the logo.
This setting affects the block RAM utilization.

Enable Logo Transparency Color — When selected, this allows for run-time
programmability of a specified color key that becomes transparent.

Enable Logo Per Pixel Alpha — When selected, this adds per pixel alpha blending
functionality for the logo.
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User Parameters

Chapter 4:

Design Flow Steps

Table 4-1 shows the relationship between the fields in the Vivado IDE and the User
Parameters (which can be viewed in the Tcl Console).

Table 4-1:

Vivado IDE Parameter to User Parameter Relationship

Vivado IDE Parameter/Value

User Parameter/Value

Default Value

Top-Level Parameters

Number of Video Components NUM_VIDEO_COMPONENTS 3
Samples per Clock SAMPLES_PER_CLOCK 1
Maximum Data Width MAX_DATA_WIDTH 8
Maximum Number of Columns MAX_COLS 3,840
Maximum Number of Rows MAX_ROWS 2,160
Video Format VIDEO_FORMAT RGB

RGB 0

YUV 4:4:4 1

YUV 4:2:2 2

YUV 4:2:0 3
Number of Layers NR_LAYERS 4

Layer Parameters

Layer i Video Format LAYERi_VIDEO_FORMAT RGB

RGB 0

YUV 4:4:4 1

YUV 4:2:2 2

YUV 4:2:0 3

RGBA 5

YUVA444 6

RGBX8 10

YUVX8 11

YUYV 12

RGBA8 13

YUVAS 14

RGBX10 15

YUVX10 16

RGB565 17

Y_UVs8 18

Y_UV8_420 19

RGB8 20
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Table 4-1:

Chapter 4:

Vivado IDE Parameter to User Parameter Relationship (Cont’d)

Design Flow Steps

Vivado IDE Parameter/Value

User Parameter/Value

Default Value

YUV8 21

Y_UV10 22

Y_UV10_420 23

Y8 24

Y10 25

BGRAS8 26

BGRX8 27

uyvys8 28
Layer i Enable Global Alpha LAYER{_ALPHA FALSE
Layer i Enable Scaling LAYERi{_UPSAMPLE FALSE
Layer i Maximum Width LAYERi_MAX_WIDTH 1,920
Layer i Interface Type LAYER{_INTF_TYPE Memory

Memory 0

Stream 1

Logo Parameters

Enable Logo Layer LOGO_LAYER FALSE
Maximum Number of Columns for Logo | MAX_LOGO_COLS 64
Maximum Number of Rows for Logo MAX_LOGO_ROWS 64
Enable Logo Transparency Color LOGO_TRANSPARENCY_COLOR FALSE
Enable Logo per Pixel Alpha LOGO_PIXEL_ALPHA FALSE

Output Generation

For details, see the Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 3].

Constraining the Core

This section contains information about constraining the core in the Vivado Design Suite.

Required Constraints

This section is not applicable for this IP core.

Device, Package, and Speed Grade Selections

This section is not applicable for this IP core.
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Clock Frequencies

This section is not applicable for this IP core.

Clock Management

This section is not applicable for this IP core.

Clock Placement

This section is not applicable for this IP core.

Banking

This section is not applicable for this IP core.

Transceiver Placement

This section is not applicable for this IP core.

I/0 Standard and Placement

This section is not applicable for this IP core.

Simulation

For comprehensive information about Vivado simulation components, as well as
information about using supported third-party tools, see the Vivado Design Suite User
Guide: Logic Simulation (UG900) [Ref 5].

ﬁ IMPORTANT: For cores targeting 7 series or Zynq-7000 devices, UNIFAST libraries are not supported.
Xilinx IP is tested and qualified with UNISIM libraries only.

Synthesis and Implementation

For details about synthesis and implementation, see the Vivado Design Suite User Guide:
Designing with IP (UG896) [Ref 3].
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Chapter 5

Example Design

This chapter provides two example systems that include the Video Mixer. One is a
simulation example design and the other one is a synthesizable example design. Important
system-level aspects when designing with the Video Mixer are highlighted in these example
designs, including:

« Video Mixer usage with memory mapped AXI4 interface memory layers.
« Typical usage of the Video Mixer in conjunction with other cores.
« Run-time configuration of the Video Mixer by programming registers on-the-fly.

Note: The synthesizable example design is only available on the Xilinx® KC705 evaluation board.
To open the example project, perform the following:

1. Select the Video Mixer IP from the Vivado® IP catalog.

2. Double-click the selected IP or right-click the IP and select Customize IP from the
menu.

3. Configure the build-time parameters in the Customize IP window and click OK. The
Vivado IDE generates an example design matching the build-time configuration.

4. In the Generate Output Products window, select Generate or Skip. If Generate is
selected, the IP output products are generated after a brief moment.

5. Right-click Video Mixer in Sources panel and select Open IP Example Design from the
menu.

6. Inthe Open IP Example Design window, select example project directory and click OK.
The Vivado software then runs automation to generate the example design in the
selected directory.

The generated project contains two example designs. Figure 5-1 shows the Source panel of
the example project. Synthesizable example block design, along with top-level file, resides
in Design Sources catalog. A corresponding constraint file is also provided for the
synthesizable example design. Simulation example design files (including block design file,
SystemVerilog test bench and another task file) are under Simulation Sources.
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Chapter 5: Example Design
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Figure 5-1:

Video Mixer Example Project Source Panel

Simulation Example Design

The simulation example design contains the following video IP cores: Video Test Pattern
Generator, Video Mixer, Video Timing Controller, and the AXI4-Stream to Video Output
bridge. The design also contains a AXI Verification IP (VIP) core (to enable register
programming) connected to an AXI interconnect. An AXI block RAM (BRAM) controller with
associated block RAM memory is also connected to this AXI interconnect.

Note: The simulation example design currently has limited configurability as it is fixed to have two
layers: the main streaming layer, and one additional memory layer.
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AXI VIP acts as AXI master in the system to drive the TPG, Video Mixer, and Video Timing
Controller cores. It configures width, height, pattern, and other registers of the TPG core.
Next, the layer properties of the Video Mixer are programmed. Then, timing parameters of
the Video Timing Controller core are configured by the AXI VIP core.

After all configurations are performed, the AXI VIP core starts the TPG, Video Mixer, and
Video Timing Controller cores. Because this design runs an RTL simulation, running large
video frames can take a long time. Xilinx recommends running a small video size for this
example design, by default a 64 x 64 frame dimension is being programmed. Width and
height values, as well as other register settings, can be changed in the simulation test bench
v_mix_0_exdes_tb.sv file.

The v_mix_0 core is in free-running mode after kickoff. It generates video stream pixels at
a clock rate of ap_c1lk.

The v_mix_0 core receives video frames through the AXI4 stream interface of the master
layer, and additionally reads frames from a memory mapped AXI4 memory layer, that are
then mixed and sent out over the AXI4-Stream master interface.

The AXI4-Stream to Video Out core, working with the Video Timing Controller, interfaces
with the AXI4-Stream interface implementing a timed Video Protocol to a video source
(parallel video data with video syncs and blanks).

The simulation example design checks the output port named locked from the
AXI4-Stream to Video Out core. The locked port indicates that the output timing is locked
to the output video. The simulation example design indicates that the test completed
successfully if video lock is successfully detected.

Synthesizable Example Design

The difference between the Synthesizable design and the Simulation example design is the
use of the MicroBlaze™ microprocessor instead of the AXI VIP core as AXI4 master. Also, the
synthesizable design uses the MIG IP core for DDR memory access. The locked port of
AXI4-Stream to Video Out is connected to axi_gpio_lock core and the MicroBlaze polls
the corresponding register for a sign that the test passed.
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Figure 5-3: Synthesizable Example Block Design
The synthesizable example design requires both Vivado and Xilinx SDK tools.

The first step is to run synthesis, implementation and bitstream generation in Vivado. After
all those steps are done, select File > Export > Export Hardware. In the window, select
Include bitstream, select an export directory and click OK.

The remaining work is performed in the Xilinx SDK tool. The Video Mixer example design
file can be found in the following SDK directory:

(/data/embeddedsw/XilinxProcessorIPLib/drivers/v_mix_v3_0/examples/

The example application design source files (contained within examples folder) are tightly
coupled with the v_mix example design available in Vivado IP catalog.

vmix_example. tcl automates the process of generating the downloadable bit and el f
files from the provided example haf file.

To run the provided Tcl script:

Copy the exported example design hdf file in the examples directory of the driver
Launch the Xilinx Software Command-Line Tool (xsct) terminal

cd into the examples directory

> W

Source the tcl file xsct:
$>source vmix_ example.tcl
5. Execute the script:

xsct¥>vmix_example <hdf_file_name.hdf>
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The Tcl script performs the following:

Create workspace

Create HW project

Create BSP

Create Application Project

Build BSP and Application Project

After the process is complete, the required files are available in:

bit file -> vmix example.sdk/vmix_example_hw_platform folder
elf file -> vmix_example.sdk/vmix_ example_design/{Debug/Release} folder

Next, perform the following steps to run the software application:

i? IMPORTANT: To do so, make sure that the hardware is powered on and a Digilent Cable or an USB
Platform Cable is connected to the host PC. Also, ensure that a USB cable is connected to the UART port
of the KC705 board.

Launch SDK.

Set workspace to vmix_example. sdk folder in prompted window. The SDK project
opens automatically (if a welcome page shows up, close that page).

Download the bitstream into the FPGA by selecting Xilinx Tools > Program FPGA. The
Program FPGA dialog box opens.

Ensure that the Bitstream field shows the bitstream file generated by Tcl script, and then
click Program.

Note: The DONE LED on the board turns green if the programming is successful.

A terminal program (HyperTerminal or PuTTY) is needed for UART communication. Open
the program, choose appropriate port, set baud rate to 115,200 and establish Serial port
connection.

Select and right-click the application vmix_example_designin Project_Explorer
panel.

Select Run As > Launch on Hardware (GDB).

Select Binaries and Qualifier in window and click OK.

The example design test result are shown in terminal program.

For more information, visit www.xilinx.com/tools/sdk.htm.

When executed on the board, the operations are listed in readme. text in the examples
folder. Video input tested are 1080p and 720p.
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Chapter 6

Test Bench

There is no test bench for this IP core release.
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Appendix A

Verification, Compliance, and
Interoperability

This appendix provides details about how this IP core was tested for compliance with the
protocol to which it was designed.

Simulation

A highly parameterizable test bench was used to test the Video Mixer in Vivado®
High-Level Synthesis (HLS). Testing included the following:

Register accesses

Processing multiple frames of data

Varying IP throughput and pixel data width

Testing the Video Mixer with AXI4-Stream and memory mapped AXI14 interface layers
Testing of various frame sizes

Varying parameter settings

Hardware Testing

The Video Mixer core has been validated at Xilinx® to represent many different
parameterizations. A test design was developed for the core that incorporated a
MicroBlaze™ processor, AXI4-Lite interconnect, and various other peripherals. The
MicroBlaze processor was responsible for:

Programing the video clock to match tested video resolution
Configuring the video IP cores with different resolutions
Launching the test

Reporting the Pass/Fail status of the test and any errors that were found
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Interoperability

The core slave (input) and master (output) AXI4-Stream interface can work directly with any
core that produces RGB, YUV 4:4:4, YUV 4:2:2, or YUV 4:2:0 video data.
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Appendix B

Upgrading

This appendix contains information about upgrading to a more recent version of the IP
core.

Upgrading in the Vivado Design Suite

This section is not applicable for the first release of the core.

Changes from v1.0 to v2.0

The register offsets have been changed so that each layer is grouped together rather than
grouping layer properties together.

Two buffers are provided for semi-planar formats. In v1.0 of the IP, the chroma buffer
address was automatically set based on frame size and stride. In v2.0 of the IP, the chroma
buffer address must be specified via a register.

Two new streaming video formats, RGB with Alpha and YUV 4:4:4 with Alpha, are now
available for use with the memory formats RGBA8, BGRA8, and YUVAS.

New memory video formats have been added: BGRX8 and UYVY8.

Both 32-bit and 64-bit addressing are supported for the memory interfaces.

Parameter Changes

A new parameter was added: AXIMM_ADDR_WIDTH. Both 32-bit and 64-bit addressing are
supported for the memory interfaces.

Port Changes

There are no port changes.

Other Changes

There are no other changes.
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Appendix C

Application Software Development

The Video Mixer core is delivered with a bare-metal driver as part of the SDK installation.
The driver follows a layered architecture wherein layer 1 provides basic register peek/poke
capabilities and requires you to be familiar with the register map and inner workings of the
core. Layer 2, on the other hand, abstracts away all the lower level details and provides an
easy to use functional interface to the Video Mixer. Xilinx® recommends always using layer
2 APIs to interact with the core.

Building the BSP

When the Board Support Package (BSP) is built, the Video Mixer driver inherently pulls in
the required dependency, that is, the video common driver. This driver contains the
enumerations for video specific information like color format, color depth, frame rate, etc.
It also defines fundamental data types to represent the video stream, timing and window
that are used in the Video Mixer driver and is common across all Xilinx video drivers.

During the build process the Video Mixer driver extracts the Video Mixer hardware
configuration settings from the provided hardware design file.

Prerequisites

If optional layers are enabled and configured as "Memory," there are certain requirements
that must be taken care of while programming the core.

1. The core itself does not have a data realignment engine and therefore the application
software must align the layer memory addresses before writing to the registers. The
alignment requirement is specified below, and makes sure that the start address is
aligned with the width of the memory interface.

2 x Pixels per Clock x 4 Bytes
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2. When setting up the memory layer window, also the stride (in bytes) must be aligned as
above to make sure that every row of pixels starts at an aligned memory location. To
compute the stride from a window width in pixels the following equation can be used.

Stride in Bytes > (Width x Bytes per Pixel);

Bytes per pixel varies per video in memory format, and is described in the section
detailing the memory mapped AXI4 interface. Note that padding bytes are sometimes
necessary (hence the > in the equation) to make sure that every row of pixels starts at an
address that is aligned with the size of the data on the memory mapped interface.

3. Layer Window Start Horizontal Position and Width must be a multiple of Pixels per
Clock as selected in the Vivado Integrated Design Environment (IDE) for this core.

Modes of Operation

The Video Mixer supports two modes of operation, which require two different
programming models.

« Auto Restart Mode (Default) — The driver initialization routine configures the Video
Mixer for auto restart mode. In this mode, after the current frame is processed the core
automatically triggers the start of the next frame processing. Consequently, the core
can keep on processing frames without any software intervention, with settings applied
when the core was started. This mode is used when there is no need to make frame
synchronous changes to the core registers. This is the case if streaming layers are being
used.

You can switch to Auto Restart Mode, at any time, by disabling the interrupts, using the
XVMix_InterruptDisable APIL

« Interrupt Mode — When using memory layers, frame synchronous changes to the layer
memory buffer address are key for the correct operation of the Video Mixer, that is,
reading from memory needs to be synchronized with writing to memory by for
example a graphics engine. In this case, the interrupt mode should be used. In this
mode, the interrupt (IRQ) port of the core needs to be connected to a system interrupt
controller.

When an interrupt is triggered, the core interrupt service routine (ISR) checks to
confirm if current frame processing is complete. It then calls a user programmable
callback function, if any. In the callback function, the register settings for the next frame
should be programmed, that is, what layer buffer address a layer should read next from.
Finally, the interrupt service routine triggers the core to start processing the next
frame.

An application must perform the following tasks to configure the core for Interrupt
mode.
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- Register the core ISR routine XVMix_InterruptHandler with the system
interrupt controller.

- Register the application callback function that should be called within the interrupt
context. This can be done using the API XVMix_SetCallback.

- Enable the interrupts by calling provided API XVMix_InterruptEnable.

Usage

To better understand the driver usage, consider the following test case scenario. Suppose
the core in the design was configured with few memory layers and each layer has certain
optional features, like alpha blending and/or scaling enabled, and that the logo layer is
enabled with the optional color key feature. Because memory layers are being used, there
are sources in the design that generates frame data for each of the Video Mixer memory
layers. The application should allocate required frame buffer space per layer in memory.
These addresses should be updated during the interrupt.

To integrate and use the Video Mixer driver in the application, the following steps should be
followed:

1. Include the driver header file xv_mix_12.h that contains the mixer instance object
definition.

2. Declare an instance of the Video Mixer type: XV_Mix_12 Mixer;
3. Initialize the Video Mixer instance at power on:

int XVMix_Initialize(XV_Mix 12 *InstancePtr, ulé6 DeviceId);

This function accesses the hardware configuration and initializes the core to the power
on default state.

- Set Master layer to 1080p.

- Set Background color to blue.

- Enable the master layer.

- Set the operating mode to Auto Restart.

4. If the core is operating in interrupt mode, the application needs to perform the tasks
mentioned, that is, register the ISR with the system interrupt controller and set the
application callback function. This function is called by the Video Mixer driver when the
frame done IRQ is triggered.

5. If applicable, write the application level callback function. An example action to be
performed here would be to update layer buffer addresses from where to read the next
frame data for each layer. This allows the application to render the frame updates in
memory, on screen.
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6. Write a function to configure the core. The following is a sample event sequence that
might be performed here:

a. Set the master layer video stream properties:

void XVMix_SetVidStream (XV_Mix_ 12 *InstancePtr,
const XVidC_vVideoStream *StrmIn) ;

b. For each memory layer, set the frame buffer base address:

int XVMix_SetLayerBufferAddr (XV_Mix_12 *InstancePtr,
XVMix_LayerId LayerId,
UINTPTR Addr) ;

c. For semi-planar formats, set the buffer base address for the second plane:

int XVMix_SetLayerChromaBufferAddr (XV_Mix_ 12 *InstancePtr,
XV_Mix_LayerId LayerId,
UINTPTR Addr) ;

d. If logo layer is enabled, load the logo data:

int XVMix_LoadLogo (XV_Mix_12 *InstancePtr,
XVidC_VideoWindow *Win,
u8 *RBuffer,
u8 *GBuffer,
u8 *BBuffer);

e. If logo color key feature is enabled, set the default color key data:

int XVMix_SetLogoColorKey (XV_Mix_12 *InstancePtr,
XVMix_LogoColorKey ColorKeyData) ;

f. For each layer, set the window properties:

int XVMix_SetLayerWindow (XV_Mix_12 *InstancePtr,
XVMix_LayerId LayerId,
XVidC_VideoWindow *Win,
u32 StrideInBytes) ;

g. Enable the interrupts (if operating in interrupt mode):

void XVMix_InterruptEnable (XV_Mix_12 *InstancePtr);

h. Enable the master layer (and additional memory layers if needed):
int XVMix_LayerEnable (XV_Mix_12 *InstancePtr, XVMix_ LayerId LayerId) ;
i. Finally, start the core:

void XVMix_Start (XV_Mix_ 12 *InstancePtr);

7. If optional features like alpha blending or scaling are enabled for a given layer, then
these can be updated using the provided APIs.

int XVMix_SetLayerAlpha (XV_Mix_12 *InstancePtr,
XVMix_LayerId LayerId,
ulé Alpha) ;
int XVMix_SetLayerScaleFactor (XV_Mix_ 12 *InstancePtr,
XVMix_LayerId LayerId,
XVMix_Scalefactor Scale);
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You are encouraged to experiment with other APIs that allow the layer window to be resized
or moved on the screen or change logo color key information, if applicable. Each API
provides a return value indicating if the desired action was successful or not.

Also, to help debug the Video Mixer, two Debug APIs are available that provide the state of
the core:

void XVMix_DbgReportStatus (XV_Mix_12 *InstancePtr);
void XVMix_DbgLayerInfo (XV_Mix_12 *InstancePtr, XVMix_LayerId LayerId);

Note:

a.

Video Mixer v2.0

Resolution changes are not possible on the fly. If either the master input stream
resolution changes during operation or the output resolution needs to be changed,
then the application must reset the Video Mixer, that is, toggle ap_rst_n, and
reconfigure the core for the new resolution. After reset, all registers are cleared to 0.

Certain actions cannot be performed when the core is in middle of processing a
frame. For example, if a window has to be resized or the scaling factor has to be
changed for a layer, then this layer should be disabled first. Next, apply the new
settings and lastly re-enable the layer. Alternatively, in interrupt mode these
operations can be done in the user callback function registered with the mixer
interrupt service routine.

When resizing, moving, or scaling a layer window, the driver checks to ensure that
the window properties provided does not cause the new window to go out of frame
boundary. If any of these actions cause such a condition, then the action cannot
applied and the API returns with an error code. The application code should check
the return status of all APIs to make sure the required action was completed
successfully and if not take corrective action.
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Appendix D

Debugging

This appendix includes details about resources available on the Xilinx Support website and
debugging tools.

Finding Help on Xilinx.com

To help in the design and debug process when using the Video Mixer, the Xilinx Support
web page contains key resources such as product documentation, release notes, answer
records, information about known issues, and links for obtaining further product support.

Documentation

This product guide is the main document associated with the Video Mixer. This guide, along
with documentation related to all products that aid in the design process, can be found on
the Xilinx Support web page or by using the Xilinx Documentation Navigator.

Download the Xilinx Documentation Navigator from the Downloads page. For more
information about this tool and the features available, open the online help after
installation.

Answer Records

Answer Records include information about commonly encountered problems, helpful
information on how to resolve these problems, and any known issues with a Xilinx product.
Answer Records are created and maintained daily ensuring that users have access to the
most accurate information available.

Answer Records for this core can be located by using the Search Support box on the main
Xilinx support web page. To maximize your search results, use proper keywords such as

*  Product name
+ Tool message(s)

« Summary of the issue encountered

A filter search is available after results are returned to further target the results.
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Master Answer Record for the Video Mixer

AR: 66753

Technical Support

Xilinx provides technical support at the Xilinx Support web page for this LogiCORE™ IP
product when used as described in the product documentation. Xilinx cannot guarantee
timing, functionality, or support if you do any of the following:

« Implement the solution in devices that are not defined in the documentation.
+ Customize the solution beyond that allowed in the product documentation.

« Change any section of the design labeled DO NOT MODIFY.

To contact Xilinx Technical Support, navigate to the Xilinx Support web page.

Debug Tools

There are many tools available to address Video Mixer design issues. It is important to know
which tools are useful for debugging various situations.

Vivado Design Suite Debug Feature

The Vivado® Design Suite debug feature inserts logic analyzer and virtual I/O cores directly
into your design. The debug feature also allows you to set trigger conditions to capture
application and integrated block port signals in hardware. Captured signals can then be
analyzed. This feature in the Vivado IDE is used for logic debugging and validation of a
design running in Xilinx devices.

The Vivado logic analyzer is used with the logic debug IP cores, including:

« ILA 2.0 (and later versions)

« VIO 2.0 (and later versions)

See the Vivado Design Suite User Guide: Programming and Debugging (UG908) [Ref 7].
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Hardware Debug

Hardware issues can range from link bring-up to problems seen after hours of testing. This
section provides debug steps for common issues. The Vivado debug feature is a valuable
resource to use in hardware debug. The signal names mentioned in the following individual
sections can be probed using the debug feature for debugging the specific problems.

General Checks

Ensure that all the timing constraints for the core were properly incorporated from the
example design and that all constraints were met during implementation.

« Does it work in post-place and route timing simulation? If problems are seen in
hardware but not in timing simulation, this could indicate a PCB issue. Ensure that all
clock sources are active and clean.

» If using MMCMs in the design, ensure that all MMCMs have obtained lock by
monitoring the locked port.
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Appendix E

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see
Xilinx Support.

Documentation Navigator and Design Hubs

Xilinx Documentation Navigator provides access to Xilinx documents, videos, and support
resources, which you can filter and search to find information. To open the Xilinx
Documentation Navigator (DocNav):

« From the Vivado IDE, select Help > Documentation and Tutorials.
+  On Windows, select Start > All Programs > Xilinx Design Tools > DocNav.

« At the Linux command prompt, enter docnav.

Xilinx Design Hubs provide links to documentation organized by design tasks and other
topics, which you can use to learn key concepts and address frequently asked questions. To
access the Design Hubs:

« In the Xilinx Documentation Navigator, click the Design Hubs View tab.
« On the Xilinx website, see the Design Hubs page.

Note: For more information on Documentation Navigator, see the Documentation Navigator page
on the Xilinx website.

References

These documents provide supplemental material useful with this product guide:

1. Vivado Design Suite: AXI Reference Guide (UG1037)
2. Vivado Design Suite User Guide: Designing IP Subsystems using IP Integrator (UG994)
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Vivado Design Suite User Guide: Designing with IP (UG896)

Vivado Design Suite User Guide: Getting Started (UG910)

Vivado Design Suite User Guide: Logic Simulation (UG900)

ISE to Vivado Design Suite Migration Guide (UG911)

Vivado Design Suite User Guide: Programming and Debugging (UG908)
Vivado Design Suite User Guide: Implementation (UG904)
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Revision History

The following table shows the revision history for this document.

Date Version Revision

10/04/2017 2.0 + Added second buffer pointer for semi-planar formats.
« Added 64-bit address support for memory mapped AXI4 interface.

« Register map offsets re-ordered to handle both 32 and 64-bit
addressing.

« Added UYVY8 and BGRX8 memory formats.
+ Added per pixel alpha streaming formats RGBA and YUVA444.

04/05/2017 1.0 « Added BGRAS, Y_UV10, Y_UV10_420, Y8, and Y10 to Memory Mapped
AXI4 Interface.
10/05/2016 1.0 « Added YUV 4:2:0.

« Updated Features in IP Facts.

« Updated SDK directory link in IP Facts table.

« Updated Feature Summary section.

+ Added RGBAS8 to Y_UV8_420 sections.

+ Updated description for Layer Buffer (0x0048+i*8) Register section.
« Added 0x4 0000 Logo Alpha Buffer table.

« Updated description in Logo Red Buffer (Ox1 0000) Register.

« Updated description in General Design Guidelines section.

« Updated Alpha Blending section.

» Updated description to Layer Settings and Logo Layer Settings in Design
Flow Steps chapter.

« Added Enable Logo per Pixel Alpha in Vivado IDE Parameter to User
Parameter Relationship table.

« Updated Prerequisites section.

04/06/2016 1.0 Initial Xilinx release.
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i: XI I_INX Appendix E: Additional Resources and Legal Notices

ALL PROGRAMMABLE

Please Read: Important Legal Notices

The information disclosed to you hereunder (the "Materials”) is provided solely for the selection and use of Xilinx products. To the
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special,
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a
result of any action brought by a third party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials
without prior written consent. Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to
Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support
terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use in any
application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical applications,
please refer to Xilinx's Terms of Sale which can be viewed at http://www.xilinx.com/legal.htm#tos.

AUTOMOTIVE APPLICATIONS DISCLAIMER

AUTOMOTIVE PRODUCTS (IDENTIFIED AS "XA" IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE ("SAFETY APPLICATION") UNLESS THERE IS A
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD ("SAFETY
DESIGN"). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY
TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY
AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT
LIABILITY.

© Copyright 2016-2017 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated
brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of
their respective owners.
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